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Introduction 

Audience 

The audience for this manual includes station engineers or technicians working for content 

creators or third-party providers.  

Note Media distributors are required to actively encode using the Nielsen encoding 

methodology per their service agreements with Nielsen. 

Customer Support 

Nielsen Support Location 

Nielsen Encoder Support 800-537-4872 option 2 

Encoders@nielsen.com 

Nielsen Encoder Forum https://engineeringforum.nielsen.com/encoders/ 

Nielsen Global Technology Center Nielsen 

501 Brooker Creek Blvd 

Oldsmar, FL 34677 

www.nielsen.com 

Conventions Used in this Document 

The following items appear in this document:  

Note This paragraph flags a key point, indicates a tip, or identifies an alternate way of 

performing a task. 

Important This paragraph emphasizes one or more actions that must be followed to avoid a 

catastrophic failure. 

Related Documents 

CableLabs VOD Content Encoding Profiles Specification—specification for encoding AC-3 

files 

CableLabs VOD Metadata Specification Version 1.1—specification for providing metadata for 

AC-3 files 

mailto:Encoders@nielsen.com
https://engineeringforum.nielsen.com/encoders/wp-content/uploads/2016/03/Encoding_Install_Config_Policy_Rev_G.pdf
http://www.nielsen.com/
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VOD Encoder Installation Quick Start—procedures for installing the encoder applications 

products 

Encoding and Transferring Metadata 

VOD Content Encoding 

The VOD Content Encoder (the Encoder) watermarks audio content of a VOD (Video on 

Demand) asset. In a nutshell, the Encoder reads input from an audio file, generates an 

encoded file, and sends metadata to the Nielsen Collection Facility (CF): 

Note The Encoder refers to the package that includes the VOD Content Encoder application, 

WRR Installer application, and WRR. 

Metering equipment in Nielsen co-operators’ homes captures these audio codes (also called 

watermarks) from television viewing and sends them to the CF, where back-end systems use 

them to credit viewing. 

The Encoder watermarks audio in these transport streams: 

Table 1 – Supported Audio Transport Streams 

MPEG-2 Stream in Format With Extensions 

AC3 *.mpg, 

*.m2t 

*.trp 

*.ts 

 

 

The watermark consists of a unique SID (source identifier) and a number referred to as a TIC 

(time-in-content). The Encoder inserts either or both of two types of unique SID/TIC pairs: 

 NAES II—Nielsen Audio Encoder System II, the second-generation method of 

inserting a SID (Nielsen source identifier) and time stamp into a TV signal 

 NW—Nielsen Watermarks, a newer method of audio encoding that places an audio 

watermark in a lower-frequency portion of the active program than does NAES II 

technology. Its lower-frequency position enables NW to be more robust and much 

less likely to be “compressed out” of the program audio by TV distribution. 

As individual VOD files are watermarked, the Encoder generates a ZIP metadata containing 

Metadata feed-point file, decoder and signature output logs and transmits ZIP metatdata to 

the Nielsen Collection Facility (CF): 
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 ZIP Metadata – ZIP metadata is generated at the end of VOD content encoding 

session. The ZIP file name format is <SID>_<TIC>_<StartingTimeStamp>.zip. The 

ZIP contains following files 

o Metadata feed-point xml file—contains information Nielsen uses to uniquely 

identify the VOD asset. The metadata file contains the SID, a range of TICs, 

asset ID, and information about the VOD content. The metadata file name 

format is <SID>_<TIC>_nmr.xml. 

o CableLabs ADI.xml file (optional)—may be attached for VOD content 

compliant with CableLabs standard (AC-3 audio). The ADI.xml file, which the 

provider supplies and is distributed to cable head-ends, must conform to 

CableLabs® Asset Distribution Interface Specification Version 1.1. 

o Decoder and signature logs files --- Decoder logs are generated for NAES-II , 

NW watermarks and signature logs are generated for PAS, DNA, NDASH 

and UNITAM signature algorithms. Decoding and signature generation is 

done automatically during encoding of VOD contents. 

VOD Content Encoder Components 

The VOD Content Encoder consists of the following the components: 

 VOD Content Encoder software—an application that encodes, decodes, and can 

send zip metadata containing Metadata feed-point file, decoder and signature output 

logs directly to the CF or to another computer in your facility for forwarding to the CF. 

The application can be run from a graphical user interface, a command-line tool, 

(ContentCodeCmd), or a file trigger service. See “Install the VOD Content Encoder 

Application” on page 14. 

 SID/TIC Server (the Server)—an application that maintains mirror databases on the 

Server host computer. Before responding to any Encoder request and, for almost any 

transaction, the Server first verifies all databases are present and identical. The 

Server runs as a service that automatically starts when the computer hosting it boots. 

A VOD Discovery Service “listens” on a port for “discovery” requests from the 

Encoder. See “Install the SID/TIC Server” on page 15. Discovery Service functionality 

is not supported workflows that include cloud interactions. Contact Nielsen Encoder 

Support for a Discovery Service workaround. See 5. 

The Server allows only one connection at a time, completely processing each request 

before servicing the next. Since the processing of a request requires only a fraction of 

a second, the serialization of processing should not be a problem, even in the busiest 

encoding facility. If more than one Server is configured, each Server allocates a 

different range of SID/TICs. 

 WRR—an encrypted Watermark Resource Record file (the WRR) that is 

preconfigured with client-specific SID/TIC information 

The WRR can be installed with the WRR installer during or after installation of 

SID/TIC server software. The SID/TIC server needs the WRR for handling Encoder 

requests. The WRR contains the following information: 

○ WRR Header  
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○ Serial Number—number that uniquely identifies the WRR provided to client  

○ WRR state—indicates the current WRR state 

The WRR can be in one of the following states: 

 ReadyToInstall—indicates the WRR can be used for a new WRR installation 

or upgrade of an existing WRR 

 Active—indicates the WRR is installed and will be used for TIC allocation 

 InActive—indicates the WRR is installed and cannot be used for TIC 

allocation 

 ManualBackupCopy—indicates the WRR was created when Deactivate 

WRR was done on the WRR Installer. A WRR in this state cannot be used 

for installation, upgrade, or TIC allocation. 

 AutomaticBackupCopy—indicates the SID/TIC service created the WRR on 

every successful encoding session. A WRR in this state cannot be used for 

installation, upgrade, or TIC allocation. 

○ WRR creation date—identifies date when Nielsen Encoder Support created the 

WRR  

○ WRR Modification date—identifies WRR modification date for the last successful 

encoding session 

○ Redundancy—indicates the WRR redundancy status 

 NoRedundancy—indicates the WRR does not support redundancy 

 PrimaryWRR— indicates the WRR supports redundancy and the WRR is the 

Primary WRR of the redundant WRR system 

 RedundantWRR— indicates the WRR supports redundancy and the WRR is 

the redundant WRR of the redundant WRR system 

○ WRR Installation Validity—indicates the last date for the WRR to be used for 

installation or upgrade. After the WRR installation Validity Expiry you get new 

WRR from Nielsen Encoder Support. 

○ NoOfRecords—number of SID/TIC records in the WRR 

 File Transfer Manager—optional software used to send ZIP metadata files to the CF 

from a system without the Encoder installed. At scheduled times, the File Transfer 

Manager Service transfers data to the CF. If the connection is disrupted, the manager 

or service automatically retries to send the data. For batch file encoding, you must 

install the File Transfer Manager. See “Installing the File Transfer Manager” on page 

17. 

 ServicesMonitorTool—an application that is automatically installed with the VOD 

Content Encoder software, standalone File Transfer Manager software, and SID/TIC 

Server. The ServicesMonitorTool runs in the background and is accessible from the 

taskbar. The application has a graphical user interface (GUI) that enables you to 

configure the application to monitor services and restart the services when they are 

not running. By default, the GUI displays an alert when metadata files fail to transfer 

to the CF. Although you can configure the transfer error popup to not appear, doing 

so is not recommended. See “Configure the ServicesMonitorTool” on page 47. 
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Overview of the File Transfer Options 

To receive credited viewing, the ZIP metadata file containing the feed-point metadata file that 

correspond with the encoded files must be sent to the CF. You can use of several options to 

send these ZIP files directly or indirectly to the CF. See also the workflows that begin on page 

22. 

 Directly transfer to data collection facility—the Nielsen File Transfer Service uses 

Secure FTP to directly send files from the Encoder to the CF. 

 Transfer files to a local sever—the Encoder uses the FTP function that is included in 

the VOD Encoder application or a third-party FTP application to transfer files to a 

transfer server and then the Nielsen File Transfer Service sends the files to the CF. 

Important Install or enable only one FTP application on a computer. 

In addition to these transfer flows, there are different configurations that you can use: 

 Manually send the zip metadata files  

 Use the File transfer Service to automatically send the zip metadata files 

The encoder sends zip file containing the XML file with metadata in Table 2  to the CF: 

Table 2 – Feed-Point Metadata File Contents 

Field Description Comment 

ADIFileName Name of the CableLabs file (if 

any) that is transferred to the 

CF with the Feed-Point 

Metadata file 

Optional 

Note ADI files are created by applications 

not under the control of Nielsen, 

therefore, we cannot guarantee that 

the ADI file is well-formed. 

ProviderId ID of the content provider May be derived from a Provider ID 

field in the CableLabs file 

Provider Name of the content provider May be derived from a Provider field in 

the CableLabs file 

AssetId ID of the encoded content May be derived from an Asset ID field 

in the CableLabs file 

AssetName Name of the encoded content May be derived from an Asset Name 

field in the CableLabs file 

EpisodeId Unique identifier given to each 

episode of a given series 

String characters, such as Episode 

#45 (may be derived from an Asset 

Name field in the CableLabs file) 

OriginatorId Unique Nielsen number to link 

back to the content provider. 
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Field Description Comment 

WatermarkTime The actual system time that the 

watermarking process started, 

expressed as UTC 

(Coordinated Universal Time) 

 

SID Value of the SID that was 

inserted into this asset 

 

StartingTIC Value of first TIC presented to 

the watermarking algorithm for 

insertion into the asset. 

First TIC (it may be significantly offset 

from the AllocatedStartTIC, depending 

upon the location in the stream of the 

first frame of audio) 

EndingTIC Value of the last TIC that the 

encoder presented to the 

watermarking algorithm for 

insertion into the asset 

Last TIC (may be significantly less 

than the value of the AllocatedEndTIC, 

depending upon the location in the 

stream of the last frame of audio) 

AllocatedStartTIC Value of the first TIC reserved—

and the first TIC presented to 

the watermarking algorithm for 

insertion into the asset 

 

AllocatedEndTIC Value of the last TIC reserved 

for this asset 

 

HDContent True if and only if content is 

high definition. 

Not currently used (undefined) 

FileSizeBytes Size of the encoded file in bytes  

FileSizeSeconds Approximate duration (in 

seconds) of the encoded file 

 

 

Methods of Transferring Metadata 

There are a few different methods for transferring ZIP metadata files to the CF. 

 VOD Content Encoder application—if you are directly transferring files from the 

computer that does the encoding to the Nielsen CF, you configure the File Transfer 

Manager from within the VOD Content Encoder application itself. 

 File Transfer Manager application (FTM)—if the File Transfer Manager application is 

on a different computer from the VOD Content Encoder application, you can use the 

FTM application to transfer the metadata files to the CF. See “Transfer Files Using 

the File Transfer Manager” on page on page 37. 

File Trigger Service Overview 

The File Trigger Service (the Trigger Service) performs content-based encoding according to 

parameters defined in a standard XML file (see Table 3 for the parameters and the Appendix 

for the format).  
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1. The Trigger Service reads the encoder configuration. See Figure 8 – Encoder 

Configuration (System Setup) Window on page 21 for details on setting these 

parameters. 

2. The Trigger Service extracts the following settings entered into the 

FileTriggerManager window. See Figure 15 – File Trigger Manager Window on 

page 27. 

 XML File Path—the path to the EncoderParamFolder, which is the extracted 

path name and is sometimes referred to as the encoder parameter folder. 

3. From the encoder configuration file, the Trigger Service extracts the SID/TIC 

Server IP address and all other configuration settings directly related to content-

based encoding. 

4. The Trigger Service repeatedly checks EncodeParamFolder, searching for all 

files that have the extension “xml.” 

5. The Trigger Service makes a list of those xml files and processes the xml files, 

one at a time, as follows: 

a. Opens the xml file 

b. Reads the file 

c. Validates all encoder parameter settings in the file 

d. Closes the file. See Table 3 for a complete listing of settings that may be 

extracted from the xml file. 

e. The Trigger Service extracts settings from the xml file and uses them as the 
parameters to encode the specified video source file. The Trigger Service 
uses the same encoding process (including interacting with the SID/TIC 
server, creating and naming metadata files, and logging status and errors) 
that the VOD Content Encoder application uses. 

f. When the source file has been successfully encoded, the Trigger Service 
deletes the corresponding xml file from the drive. 

6. When all files in the xml list are fully encoded, the Trigger Service repeats steps 

4 and 5. 

7. The Trigger Service runs until it is manually stopped. 
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Standard XML File Parameters 

Table 3 – Parameters Defined for Standard XML File-Encoding 

XML Label 

Parameter 

Data Type Parameter Usage 

InputFile char * Full path name of the source video file 

OutputFile char * Full path name of the encoded video file that the 

File-Trigger encoder creates 

AdiFile char * (Optional) full path name of the folder that holds 

CableLabs ADI Asset Distribution Interface. files 

SID int The SID to be used in the upcoming encoding 

session 

AssetId char * The asset ID to be reported in the metadata file 

for the clip that is about to be encoded 

AssetName char * The asset name to be reported in the metadata 

file for the clip that is about to be encoded 

EpisodeId char * The optional episode ID to be written to the 

feed-point metadata file. If the episode ID is not 

found in the trigger file An XML file whose 

appearance in a specific folder triggers the start 

of a VOD-content encode. The path where these 

trigger files are located is identified by the 

"EncoderParamFolder" setting in the 

EncoderConfig.txt file in the VOD ROOT / etc 

folder. , it may be read from the ADI XML file. 

javascript:kadovTextPopup(this)
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Requirements 

Environment 

 One or more computers, depending on workflow (see pages 22 and 24) 

○ Dedicate all computers used to perform VOD Content Encoding solely to 

encoding:  

Important To permit the encoding software to run without interference, disable antivirus and firewall 

programs. If this is not possible, add the *.exe files to the “exclude” or “trust” list in your 

antivirus software. For details, see “Encoder Services Are Not Running or Repeatedly 

Fail” on page 49. 

○ Do not install software that does not relate to encoding such as email, word 

processing, spreadsheets, etc. 

 Platforms—one of the following Microsoft operating systems: 

○ Windows 7 32- and 64-bit 

○ Windows 10 32- and 64-bit 

○ Windows Server 2008,32-bit and 64-bit 

○ Windows Server 2012,32-bit and 64-bit 

○ Windows Server 2016,32-bit and 64-bit 

 Preferred screen resolution of 1024 x 768 pixels, although 800 x 600 is acceptable 

 IP connectivity 

VOD Content Encoding Package 

The installation package for the VOD Content Encoder includes the following items: 

 VOD Content Encoding application 

 File Transfer Manager application 

 SID/TIC Server and WRR Installer application 

 1 or 2 WRR (watermark resource record) files with optional SID or redundancy status 

indicated in the file name 

Note In configurations where having a single point of failure is unacceptable, you can install 

two SID/TIC Servers in the network. For such setups, Nielsen provides a WRR for each 

active SID/TIC Server. Both WRRs are configured with the same SIDs; however, for 

each SID in the list, each Server manages a unique set of TICs.  
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Digital Assets 

Important All digital assets processed by the VOD Content Encoder must be clean: they cannot 

contain any Nielsen watermarks. 

Supported Formats 

 MPEG-2 transport stream files with audio stream in AC3 format conforming to 

CableLabs Content Encoding Specification MD-SP-VOD-CEPT-I01-040107 

 AC3 files—48 kHz 

Note The VOD Content Encoder does not support encoding of MPEG files with both AC3 and 

PCM in the same file. 

Install the Software Applications 

Important To permit the encoding software to run without interference, disable antivirus and firewall 

programs. If this is not possible, add the *.exe files to the “exclude” or “trust” list in your 

antivirus software. For details, see “Encoder Services Are Not Running or Repeatedly 

Fail” on page 49. 

As you perform the installation procedures in this section, keep in mind that we want two 

results from the process: encoded files to be provided for viewing and transfer of metadata 

files to the Nielsen CF to enable crediting of viewing.  

Install the VOD Content Encoder Application 

1. If you have not already done so, extract the VOD Installer zip file. 

2. Browse to the VOD Encoder folder and double-click autorun.exe. The Nielsen 

VOD Content Encoder installation window appears. 
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Figure 1 – Installation Window 

3. Click Install VOD Content Encoder. 

4. Click Next. 

5. Enter your user name and company name. 

6. Click Next. 

7. Click Install. A message appears regarding changes to your firewall software. 

See Figure 2. 

 

Figure 2 – Firewall Message 

8. Assuming you have cleared this installation with your IT administrator, click Yes. 

A command line window appears and shows progress then closes and a 

message appears indicating the installation is complete. 

9. If prompted, follow the prompt to install Microsoft Visual C++ 2010 x86 

Redistributable Package. 

10. If prompted, follow the prompt to install Microsoft .Net Framework 4. 

11. On the InstallShield Wizard, click Finish. 

Install the SID/TIC Server 

Important A computer that hosts a SID/TIC server can have only one WRR installed at a time. A 

network, however, can have more than one SID/TIC Server running on it.  
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1. Browse to the VOD Encoder folder. 

2. Double-click autorun.exe in VOD Encoder folder. The Nielsen VOD Content 

Encoder installation window appears. See Figure 1. 

3. Click Install SID/TIC Server. 

4. Click Next. 

5. Enter your user name and company name. 

6. Click Next. 

7. Click Install. 

8. Click OK. The WRR Installer window appears. 

9. On the WRR Installer application window, click Install WRR. See Figure 3 and 

Figure 4. 

 

Figure 3 – WRR Installer Application – Install WRR 

10. To load the WRR file provided by Nielsen Encoder Support, on the Install WRR 

window, click Load WRR. 
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Figure 4 – Install WRR Window – Load and Install WRR 

11. Browse to the location of the WRR that Encoder Support sent to you and click 

Open. 

12. Click Install. 

13. Do one of the following: 

 If the installation was successful the Install WRR dialog box closes. Go to 

step 14. 

 If an error occurred, contact Nielsen Encoder Support. 

14. Close the WRR installer. 

15. Assuming you have cleared this installation with your IT administrator, click Yes. 

A command line window appears and shows progress then closes, followed by 

an indication that the installation is complete. 

16. If prompted, follow the install Microsoft Visual C++ 2013 x86 Redistributable 

Package. 

17. If prompted, follow the prompt to install Microsoft .Net Framework 4. 

18. On the InstallShield Wizard, click Finish. 

19. Click Exit. 

Installing the File Transfer Manager 

Because the File Transfer Manger is incorporated into the VOD Content Encoder application, 

the installation software stops you from installing the FTM software on the same computer as 

the encoder application. 

Important If a computer already has a third-party FTP program installed, do not install the File 

Transfer Manager application on it. If, however, you want to do batch processing, you 

must disable the FTP program and install the File Transfer M anager. 
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1. Browse to VOD Encoder folder and double-click autorun.exe. The Nielsen VOD 

Content Encoder installation window appears. See Figure 1. 

2. Click Install File Transfer Manager.  

3. Click Next. 

4. Enter your user name and company name. 

5. Click Next. 

6. Click Install. When the install completes, a message appears regarding the 

firewall. See Figure 2 

7. Assuming you have cleared this installation with your IT administrator, click Yes. 

A command line window appears and shows progress then closes, followed by 

an indication that the installation is complete. 

8. If prompted, follow the prompt to install Microsoft Visual C++ 2010 x86 

Redistributable Package. 

9. If prompted, follow the prompt to install Microsoft .Net Framework 4. 

10. On the InstallShield Wizard, click Finish. 
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Configure the Software Applications 

This section covers configuration of the following: 

 VOD Content Encoder application 

 (Optional) File Transfer Manager application 

 (Optional) File Trigger Service 

Configure the VOD Content Encoder Application 

Note For instructions on configuring and using the ContentCodeCmd tool instead of the GUI 

(graphical user interface), see “Use the Command Line to Encode” on page 34. 

1. Restart your antivirus software. 

2. In your antivirus software, add the following to the list of “exclude” or “trusted” 

files: 

 SIDTicService.exe 

 STSDiscovery.exe 

 VODFileTrigger.exe 

 VODFTMService.exe 

3. From the list of programs in Windows, select VOD Content Encoder. One of the 

following occurs: 

 

Figure 5 – VOD Content Encoder Command 

 If the application can communicate with its SID/TIC Server and there is valid 

profile, the VOD Content Encoder application window in Figure 6 appears. 

Go to step 9 

 If the application do not find a valid profile file, the Profile Editor window 

(Figure 7) appears..Go to step 5 
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 If the application cannot communicate with its SID/TIC Server, the Encoder 

Configuration (System Setup) window (Figure 8) appears. Go to the next 

step. 

 

Figure 6 – VOD Content Encoder Application GUI Window 

4. From the Configure menu, select Profile Setup. See Figure 7. 

5. On the Profile Editor window, enter a name for the profile. 

Note Once you assign a Profile Name, you cannot change it. To rename a profile, you would 

have to delete the profile and add a new one. If you got a new WRR with different SID 

than delete all the profile and create new profile with new SID on WRR 

 

Figure 7 – Profile Editor Window 

6. Browse to the location of each item in Table 4. 

Table 4 – Profile Window 

Field Path 

Video Source Path Files to be encoded 

Encoded File Path Saved encoded files 
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Field Path 

ADI File Path (If applicable) ADI-compliant files to 

be transferred 

 

7. Select a SID / Distrib Source. 

8. Click Apply. 

9. From the Configure menu, select System Setup. The Encoder Configuration 

window appears. See Figure 8. 

10. Refer to Table 5 for the settings and to the figures that follow for the 

corresponding workflows. 

 

Figure 8 – Encoder Configuration (System Setup) Window 

Table 5 – Summary of Configuration Settings for Figure 8 

Workflow SID/TIC Server Parameters  

Feed-Point Transfer 

Parameters 

Figure 9 – Workflow 1 

Computer: SID/TIC Server, 

Encoder, and FTM 

Defaults Defaults 
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Workflow SID/TIC Server Parameters  

Feed-Point Transfer 

Parameters 

Figure 10 – Workflow 2 

Computer 1: SID/TIC 

Server 

Computer 2: Encoder and 

FTM 

Computers 1 and 2: IP 

address of SID/TIC 

Server, Discovery Server 

Port default 

Defaults 

Figure 11 – Workflow 3 

Computer 1: SID/TIC 

Server and Encoder 

Computer 2: File Transfer 

Manager (FTM) 

Computer 1: IP address 

of SID/TIC Server, 

Discovery Server Port 

default 

Computer 2: defaults 

Computer 1: 

communications 

parameters for Computer 2 

Computer 2: defaults 

Figure 12 – Workflow 4 

Computers 1 and 2: 

Redundant SID/TIC Servers 

Computer 3: Encoder and 

FTM 

Computers 1, 2, and 3: 

255.255.255.255, 

Discovery Server port 

default 

Computers 1 and 2: 

defaults 

Computer 3: defaults 

Figure 13 – Workflow 5 

Computer 1: SID/TIC 

Server 

Computer 2: Encoder 

Computer 3: FTM 

Computers 1 and 2: 

255.255.255.255, 

Discovery Server port 

default 

Computer 3: defaults 

Computer 1: defaults 

Computer 2: 

communications 

parameters for Computer 3 

Computer 3: defaults 

 

In each of the workflows below, the setup uses the Nielsen File Transfer Service to sends the 

data to the Nielsen Collection Facility (CF). 

Figure 9 shows a setup where a single computer performs all three functions. 

 

Figure 9 – Workflow 1 

Figure 11, Figure 10, and Figure 13 show workflows that use two computers to perform the 

three functions in different combinations. 



 VOD Content Encoder User Manual 

Release 4.0 Revision F  23 Nielsen Confidential 

 

Figure 10 – Workflow 2 

 

Figure 11 – Workflow 3 

 

 

Figure 12 – Workflow 4 
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Figure 13 shows the workflow when your plant uses three computers: one provides the 

SID/TICs, one encodes, and the third computer uses a third-party FTP application or the 

VOD Content Encoder software FTP client to transfer files to the Nielsen Collection Facility. 

 

Figure 13 – Workflow 5 
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(Optional) Configuring the File Transfer Manager 

Application 

Note Configuring the File Transfer Manager application is necessary if you install the VOD 

Content Encoder application on a separate machine.  

1. From the list of programs in Windows, select File Transfer Manager. 

2. Select the Transfer Mode and do one of the following: 

 If you select Transfer to Data Collection Facility (direct transfer to CF), the 

contents of File Transfer Configuration window is automatically filled with 

data in the configuration file provided by Nielsen. Go to step 3 and update 

Metadata Folder and Archive Folder to match them with your environment. 

 If you select Transfer to Local Server (indirect transfer to CF), go to step 3.  

 

Figure 14 – Transfer Configuration Window 

3. Complete the fields shown in Table 6. 

Table 6 – Feed-Point Transfer Parameters for Figure 14 

Field Description 

Metadata Folder The local location of the metadata files to be transferred 

Default is C:\ Nielsen\metadata. 

Archive Folder The local location of the folder where metadata files that 

already transferred are stored 

Default is C:\ Nielsen\arch_metadata 
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Field Description 

Server Address Supplied by Nielsen 

Server Login Supplied by Nielsen 

Server Password Supplied by Nielsen 

Remote Folder The folder on your transfer server where the metadata 

files are stored before transfer to the CF. Supplied by 

Nielsen 

 

4. Click Save and close the window. Files are sent on the set interval. 
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(Optional) Configure the File Trigger Service 

The VOD File Trigger Manager application is automatically installed during the VOD Content 

Encoder application installation.This is an optional service that you can use to manually or 

automatically trigger VOD content encoding. 

The File Trigger Service monitors a “watch” folder that contains an XML trigger file that 

initiates encoding with the content identified in the file. . 

Configure the Trigger Service to Run Manually 

1. From the Windows Start menu, select Nielsen > VOD File Trigger Manager. 

2. On the File Trigger Manager window, browse to the XML File Path to the trigger 

file watch folder. See Figure 15. 

Note The Appendix shows examples of the XML files. 

3. Browse to the Scratch folder. ( Tar processing support is removed in VOD 4.0 

release ). You can browse to any temp location. 

4. Click Save Config. 

 

Figure 15 – File Trigger Manager Window 
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Configuring the File Trigger Service to Run Automatically 

1. To start automatically after reboot, open the Control Panel. 

2. Select Administrative Tools > Services. 

 

Figure 16 – Administrative Tools > Services 

3. Right-click NIELSEN VOD File Trigger Service and select Properties from the 

menu. 

 

Figure 17 – File Trigger Service in Services 

4. In Startup type on the Properties window, select Automatic. 



 VOD Content Encoder User Manual 

Release 4.0 Revision F  29 Nielsen Confidential 

 

Figure 18 – FileTriggerServiceProperties 

5. Click OK. 
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Encoding and Decoding 

Encoding Using the GUI 

Important All digital assets that the VOD Content Encoder processes must be clean: they cannot 

contain any Nielsen watermarks. 

1. From the Start menu, start the VOD Content Encoder application. 

2. On the Configure menu, select Profile Setup. 

3. In the Profile List, select the profile you want and click Apply. 

 

Figure 19 – Profile Editor 

4. On the Source Video tab, select an MPEG-2 file to be encoded.  



 VOD Content Encoder User Manual 

Release 4.0 Revision F  31 Nielsen Confidential 

 

Figure 20 – Main Window 

5. Click Encode. The Feed Point Information window appears (Figure 21  

 

Figure 21 – Feed-Point Information Window 

6. If available, browse to select the corresponding ADI file, which must be compliant 

with the CableLabs specification. This step is optional. 

7. Enter the following: 

 Asset ID—uniquely identifies the asset that is being encoded. If a 

CableLabs® ADI file is identified for the asset, then this field is populated 

with the Asset ID from the ADI file. 

 Asset Name—descriptive name of the asset being encoded 

 Episode ID—(optional) uniquely identifies the episode of the asset 

Note The Dist Src ID and Name, Nielsen SID, and Duration are populated from the Encoder 

configuration and are read-only. 

8. Click OK. If the encoding session completes successfully a “Watermarking 

succeeded” message appears. “Finished processing Status” shows a return code 

of 0. See Figure 22. 
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Figure 22 – Watermarking Successful Message 

9. Click OK. 

10. Click Close. The main window also indicates the success of the encoding 

process.  

 

Figure 23 – Watermarking Success Indicators 
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Decoding Using the GUI 

To verify that encoding occurred, and that TICs were inserted, decode the encoded file. 

1. Start the VOD Content Encoder application. 

2. On the Encoded Video tab, select the file to decode. 

 

Figure 24 – Decoding 

3. Click Decode. The Decoding status dialog box appears and fills with the SID/TIC 

information. When the decoding process is complete, the dialog box displays a 

summary of the watermarks that were detected for each SID. 

 

Figure 25 – Decoder Output 
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Use the Command Line to Encode 

The command-line version of the VOD Content Encoder is called ContentCodeCmd. 

ContentCodeCmd enables you to automate encoding and decoding. 

Note You can also automate file transfer. For more information, see “Transfer Metadata Files 

to the Nielsen CF” on page 37. 

ContentCodeCmd Arguments 

The VOD Encoder package includes a batch file, InsertContentCodes.bat, which includes a 

call to ContentCodeCmd.exe. You may edit the command line arguments in this .bat file to 

meet your requirements, and then execute the .bat file to conduct a single watermarking 

session. 

Table 7 – Encoding Command Line Arguments 

 

 

Argument Description 

sid Nielsen source identifier 

input Full path name of the file containing the MPEG-2 transport stream to 

be watermarked 

output Full path name of the generated watermarked file 

assetid String for content to be encoded,  

asset name Descriptive name for content to be encoded; passed to the CF in the 

feed-point metadata file 

episode String for the episode to be encoded 

adifile Full path name for CableLabs-compliant file to be transferred to the 

CF 

discovermask Broadcast subnet address that defines the set of computers that the 

application searches in the process of “discovering” an active 

SID/TIC Server. The default value is 255.255.255.255. Depending 

upon your network configuration, you may wish to further restrict the 

broadcast address to a specific subnet. For example, if your subnet 

is 10.6.1.nnn, the UDP broadcast could be modified using the 

parameter –discovermask 10.6.1.255. 

discoverport Number of the User Datagram Protocol port on which the Discovery 

Server listens for UDP broadcasts. The default value is 6543. Only 

modify this port if it conflicts with some other service on your 

network. 

server Fixed network address of the host where the SID/TIC service is 

running. If your site uses dynamic address assignment (DHCP), you 

must use the discovery feature (do not set the server IP address). 
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Encoding Command Line Format 

When using ContentCodeCmd to encode, use this format to set the parameters described 

above: 

ContentCodeCmd   

-sid <SID>  

--input <input file>  

-output <output file> 

-assetid <asset ID> 

-asset name <asset name> 

[-episode <episode ID>] 

[-adifile <ADI file name>] 

[-discovermask <UDP broadcast address>] 

[-discoverport <UDP port number>] 

[-server <IP address>] 

Encoding Example 1 

To encode “C:\MPEGFILES\Unprocessed\test.mpg” with a Nielsen SID of 9001 and store the 

encoded file in “C:\MPEGFILES\Processed\test.mpg” … (where the sole SID/TIC service on 

the network is located on a host computer with the IP address of 10.45.212.100…): 

ContentCodeCmd -sid 9001 -input 

"C:\MPEGFILES\Unprocessed\test.mpg"-output 

C:\MPEGFILES\Processed\test.mpg --assetid "54321" -

assetname "InterestingClip" –episode “Episode 1” –

server “10.45.212.100” 

Note Because the server is automatically discovered, the –server argument is optional. 

Encoding Example 2 

To encode the same file, with the same output file name, where there are two active SID/TIC 

Servers on the system: 

ContentCodeCmd -sid 9001 -input 

"C:\MPEGFILES\Unprocessed\test.mpg"-output 

C:\MPEGFILES\Processed\test.mpg -server "127.0.0.1" -

assetid "54321" -assetname "InterestingClip" –

discovermask “255.255.255.255” 



 VOD Content Encoder User Manual 

Release 4.0 Revision F  36 Nielsen Confidential 

Use the Command Line to Decode 

You can also use ContentCodeCmd to decode Nielsen-encoded files. You can display the 

results on the screen or send them to a file. ContentCodeCmd reports the results in this 

format. 

<stream offset>, <SID>, <code type>, <audio PID>, 

<TIC/timestamp> 

The VOD Encoder package includes a batch file, DisplayCodes.bat, which includes a call to 

ContentCodeCmd.exe. You may adjust the command-line arguments in this .bat file to meet 

your requirements and then execute the .bat file to conduct a single decoding session. 

Table 8 – Decoding Parameters 

Parameter Description 

Stream offset Offset from the beginning of the stream where the end of the Nielsen 

watermark is located. The <stream offset> is expressed as  

hours : minutes : seconds 

SID Nielsen source identifier 

Code type PC” for program content or “FD” for final distributor. The VOD 

Content Encoder inserts “PC” watermarks. If the decoder reports 

“FD” watermarks, those watermarks were inserted by other Nielsen 

encoder 

Audio PID MPEG PID that identifies the AC-3 stream in which the Nielsen 

watermark was found 

TIC/Timestamp Numeric value that identifies a specific segment of the encoded 

asset. Each four-second segment of code has its own unique TIC or 

timestamp 

 

Table 9 – Decoding Command Line Arguments 

Argument Description 

-decode Activity the tool should do 

-input Full path name of the file to be decoded 

Decoding Example 

To decode file “C:\MPEGFILES\Processed\test.mpg” and store the report in 

“C:\Temp\decoder_out.txt” while displaying the report on the screen:  

ContentCodeCmd –decode –input 

“C:\MPEGFILES\Processed\test.mpg”  
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Transfer Metadata Files to the Nielsen CF 

For crediting, your plant must transfer metadata files to the Nielsen CF. There are several 

possible ways to transfer the files: through the content encoder itself, using the File Transfer 

Manager application, or using the File Trigger Service to manually or automatically transfer 

the files. 

Transfer Files Using the VOD Content Encoder GUI 

In the VOD Content Encoder application, from the File menu, select Transfer. All zip files in 

the Nielsen\metadata directory transfer to the CF or the Local Service, depending on your 

configuration. 

Transfer Files Using the File Transfer Manager 

In the File Transfer Manager application, from the File menu, select Transfer. All zip files in 

the Nielsen\metadata directory transfer to the CF. 

 

Transfer Files Using the File Transfer Service 

File transfer service periodically monitors the metadata folder and transfer all the ZIP 

metadata present in folder to CF.  
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Maintain the Encoder 

Restart the SID/TIC Server 

For instructions on restarting the SID/TIC Server, see “Verifying the SID/TIC Server Is 

Running” on page 53. 

Set Automatic Backup Path for WRR 

The default path for automatic backups is C:\Nielsen\backup. On every successful encoding, 

the application creates a copy of the WRR copy and saves it to the backup folder. If the 

system fails, you can use this backup file to restore the WRR. Contact Nielsen Encoder 

Support for assistance with restoring from a backup file (see page 5). 

1. From the Start menu, start WRR Installer. 

2. Select Configure > AutomaticBackupPath option. 

3. Select the new backup path and click OK. 

Important Do not set a password-protected network, mapped drive as the destination for saving an 

automatic backup of the WRR. 

Deactivate WRR 

1. Contact Nielsen Encoder Support (see page 5). 

Important If the WRR is deactivated, the SID/TIC server cannot serve encoding requests until the 

WRR is reinstalled. Contact the Nielsen Encoder Support before deactivating the process 

and plan accordingly. See “Customer Support” on page 5. 

2. From the Start menu, start WRR Installer. 

3. On the menu bar, select Deactivate > Deactivate and Backup WRR. 
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Figure 26 – WRR Installer Application - Deactivate WRR 

4. On the warning popup message that appears, click Yes.   

 

Figure 27 – DeactivateWRR Warning 

5. Browse to the location for backup. 
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Figure 28 – Backup Folder 

6. To complete the backup and deactivate the WRR, click OK. 

Note If the WRR is already Inactive then Deactivate WRR only confirms that a backup is 

needed and performs a backup. 

Upgrade WRR 

1. From the Start menu, open WRR Installer. 

2. Verify the Installed host WRR loaded without errors (#1 in Figure 29). 

 

Figure 29 – Upgrade WRR 
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3. Do one of the following” 

 If the WRR State is InActive (#2 in Figure 29), perform the previous 

procedure, “Deactivate WRR” and go to step 4. 

 If the WRR state is Active, contact Nielsen Encoder Support and then follow 

the deactivation procedure in the previous section. (For contact information, 

see page 5.) 

4. In Windows Explorer, browse to the file, BackupWRR, which the deactivation 

process generated. 

5. Send the BackupWRR file to Nielsen Encoder Support. The team will send the 

updated WRR to you. 

6. In the WRR Installer dialog box, verify that the WRR State is Inactive.  

7. Click Upgrade WRR (#3 in Figure 29). 

8. On the Upgrade WRR dialog box (Figure 30), click Load WRR. 

 

Figure 30 – Load and Upgrade WRR 

9. Browse to the updated WRR file you received from Nielsen. 

10. Verify the WRR is loaded without errors. If any errors occurred, contact the 

Nielsen Encoder Support team (see page 5.) 

11. To complete the upgrade, click Upgrade. If the upgrade is successful, the WRR 

Installer window refreshes with the latest Installed WRR as shown in Figure 31. 
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Figure 31 – WRR Installer Application – After Upgrade WRR. 

12. To close the WRR installer application, click the X in the upper right corner. 

Repair WRR 

If the WRR fails to load for any of the following reasons (see the status as shown in #1 in 

Figure 29), contact Nielsen Encoder Support who can provide you with a user name and 

password so that you can run the Repair WRR option. Otherwise, performing this function is 

not recommended. (For contact information, see 5.) 

 Corrupt WRR 

 Missing WRR 

 Invalid Primary WRR 

 Redundant WRR 

 

1. From the Start Menu, open WRR Installer. 

2. On the menu bar, select Repair > Repair WRR. 

3. Enter the user name and password. 

4. One of the following occurs: 

 The repair is successful and a confirmation message appears. Click OK 

 The WRR Repair fails. Contact Nielsen Encoder Support (see page 5). 
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Remove WRR 

If the WRR cannot be installed or upgraded, contact Nielsen Encoder Support (see page 5) 

who can provide you with a user name and password so that you can run the Remove WRR 

option. Otherwise, performing this function is not recommended because it removes the WRR 

database. 

1. From the Start menu, open WRR Installer. 

2. On the menu bar, select Repair > Remove WRR. 

3. Enter the user name and password. The WRR is removed from the system and 

the main window refreshes. 

Add a New Distribution Source or SID 

Nielsen Encoder Support adds new distribution source identifiers (SIDs). The process 

includes deactivating the installed WRR, generating a backup WRR, and sending the backup 

to Nielsen. Nielsen updates the WRR and sends the updated WRR to you and you install it 

on the system. 

Important Facilities that use two active SID/TIC Servers must deactivate both the primary and 

redundant WRR and send both backup copies to Nielsen Encoder Support for 

modification. 

1. Contact the Nielsen Encoder Support (see page 5). 

2. To deactivate the WRR, follow the steps in “Deactivate WRR” on page 38. 

3. If a redundant WRR is present, deactivate the WRR on the redundant SID/TIC 

server. 

4. In Windows Explorer, check the date the file was created to ensure you have the 

copy you just created. 

5. Send the copy of the backup WRR for the host and, if any, redundant SID/TIC 

server to Nielsen Encoder Support. Nielsen sends the updated WRRs to you. 

6. Follow the process in “Upgrade WRR” on page 40. 

7. For the redundant SID/TIC server, if any, repeat steps 6 through 6. 

Add a New Profile 

A profile contains the locations you specify for the video source files, encoded files, and ADI 

files plus the SID and DSID. 

1. On the VOD Content Encoder application window, from the Configure menu, 

select Profile Setup. 
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Figure 32 – Profile Editor Window 

2. Click Add. 

3. Enter a name for the profile. 

Note Once you assign a Profile Name, you cannot change it. To rename a profile, you would 

have to delete the profile and add a new one. 

4. Browse to the location for the video source(s). 

5. Browse to the location for the encoded file(s). 

6. (Optional) Browse to the location for the ADI file(s). 

7. Select a SID / Distrib Source. 

8. Click Apply. The window closes. 
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Edit a Profile 

1. On the VOD Content Encoder application window, from the Configure menu, 

select Profile Setup. 

 

Figure 33 – Profile Editor Window 

2. Click Edit. 

Note You cannot change the name of an existing profile. Instead you would have to delete the 

existing one and create a new one. 

3. Browse to the location for the video source(s). 

4. Browse to the location for the encoded file(s). 

5. (Optional) Browse to the location for the ADI file(s). 

6. Select a SID / Distrib Source. 

7. Click Apply. The window closes. 
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Delete a Profile 

1. On the VOD Content Encoder application window, from the Configure menu, 

select Profile Setup. 

2. In the Profile List, select the profile. 

3. Click Delete. A warning message appears. 

 

Figure 34 – Deleting Profile Warning Message 

4. Click OK. 

Important If you decide not to delete the profile, click Cancel rather than Apply on the Profile Editor 

window. 

5. Click Apply. The Profile Setup window closes. 
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Configure the ServicesMonitorTool 

The ServicesMonitorTool runs in the background and an icon appears in the Windows 

taskbar. This application monitors services and can restart services when they are not 

running. By default, the tool generates an alert for transfer failures of metadata to the CF. The 

ServicesMonitorTool is automatically installed with the VOD software installation and is 

configured to start automatically on system reboot. 

1. To open the VOD ServicesMonitorTool, click its icon in the Windows taskbar.  

 

Figure 35 – VOD ServicesMonitorTool Icon in Taskbar 

Note If the icon for the application does not appear in the taskbar, in the Start menu, select  

Program Files->Nielsen > ServicesMonitorTool.exe. 

 

Figure 36 – VODServicesMonitorTool 

2. To start or stop monitoring of the corresponding services, check or uncheck the 

services checkboxes.  

By default the checkboxes are enabled to monitor the VOD File Transfer Service, 

VOD File Trigger Service, Discovery Service, and SID/TIC Server Service. The 

user can only enable monitoring of those services that are installed on the 

system. 

3. Nielsen recommends that you leave Turn Off Error Popup unchecked (the default 

setting). If you check this box, the system does not generate error popups for 

metadata transfer failures to CF. 

4. To view VOD and transfer logs, click View Log. 
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5. To save the configuration to a file and minimize the application to the taskbar, 

click Save. When you click Cancel, the tool reverts to the previous configuration 

and minimizes to the taskbar.  

6. To close the dialog box, click the X in the upper right corner. 
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Troubleshooting 

Encoder Services Are Not Running or Repeatedly Fail 

Important VOD Content Encoder applications should only be installed on systems used solely for 

Nielsen encoding 

To permit the encoding software to run without interference, antivirus and firewall 

programs should be disabled. If disabling is not possible, the security software must be 

configured to permit the files listed in the procedure below to run.  

Certain Internet security virus-protection applications may interfere with the VOD Content 

Encoder services and produce any or all of the following issues: 

 SID/TIC Discovery Server does not run or its function repeatedly fails. 

 SID/TIC Server Service does not run or its function repeatedly fails. 

 File Transfer Service does not run or its function does not automatically occur. 

 After successful installation of the VOD Content Encoder application, the 

VODFTMService.exe and/or VODFileTrigger.exe files disappear from the installation 

folder. 

 After successful installation of the SID/TIC Server application, the STSDiscovery.exe, 

and/or SIDTicService.exe files disappear from the installation folder. 

When these issues could be related to antivirus software (see the rest of this 

“Troubleshooting” section for other, potential causes), do the following: 

1. To see whether your antivirus software may be interfering with the encoding 

software, do the following: 

a. Open the history feature in the antivirus program. 

b. Examine the events for evidence of the encoder services stopping or failing. 

c. Add the following files to the “exclude” or “trust” feature in your antivirus 
program. 

On a computer installed with... 

Trust or exclude this file in 

antivirus software: 

SID/TIC Server SIDTicService.exe and 

STSDiscovery.exe 

VOD Content Encoder VODFileTrigger.exe 

VODFTMService.exe 

File Transfer Manager VODFTMService.exe 

 

d. Reboot your system. 

2. In Windows Control Panel (or equivalent), select Administrative Tools. 
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3. Select Services and ensure that all of the following that apply to your system are 

operating correctly: 

 NIELSEN DISCOVERY SERVICE Status is Started. 

 NIELSEN FILE TRANSFER MANAGER SERVICE Status is Started. 

 NIELSEN SID TIC SERVER Status is Started. 

 NIELSEN VOD File Trigger Service Startup Type is Manual. 

 

4. If any services are missing, do the following: 

In Windows 7 or Windows Server, do the following:Select All Programs > 

Nielsen and right-click RestoreNielsenServices. 

5. Select Run As Administrator. 

6. Ensure that the ServicesMonitorTool is running and monitor services checkbox is 

enabled to monitor the installed services. This tool will automatically restart the 

service that is not running.  

Troubleshooting Issues with Encoding 

Use these steps to uncover root causes when encoding is not successful. 

MPEG Files Missing on Source Video Tab 

It may be that the incorrect profile for this encoding session was selected or you may need to 

create a new profile with the correct video source path. 

1. From the Configure menu on the home page of the Encoder application, select 

Profile Setup. 

2. Do one of the following: 

 Ensure that the video source path specifies the location of the file that you 

would like to encode. See “Edit a Profile” on page 45. 

 Create a new profile. See “Add a New Profile” on page 43. 

Missing Files on the Encoded Video Tab 

1. An incorrect profile for this decoding session may have been selected. 
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2. From the Configure menu on the home page of the Encoder application, select 

Profile Setup. See “Edit a Profile” on page 45. 

3. Ensure that the encoded-file path specifies the full path name of the file that you 

just encoded.  

Unable to Create or Write to the Output File 

Ensure that the encoded path that you selected is not read-only.  

Missing or Few Watermarks When File is Decoded 

If the content was difficult to encode (very quiet, for example) or if the AC-3 stream bit rate 

was too low, the Encoder may not have been able to insert as many audio codes as 

expected.  

Ensure that audio levels are properly set at the broadcast facility. See the Encoding 

Installation and Configuration Policy.  

Nielsen Unable to Detect Watermarks in Encoded File  

Ensure that audio levels are properly set at the broadcast facility. See the Encoding 

Installation and Configuration Policy.  

Ensure that you pitched the encoded file, not the original source file. 

Encoding Takes Too Long 

Ensure that other processes are not tying up the encoding system. Transferring large files to 

or from the Encoder host computer, for example, is very likely to slow down the encoding 

process. 

https://engineeringforum.nielsen.com/encoders/wp-content/uploads/2016/03/Encoding_Install_Config_Policy_Rev_G.pdf
https://engineeringforum.nielsen.com/encoders/wp-content/uploads/2016/03/Encoding_Install_Config_Policy_Rev_G.pdf
https://engineeringforum.nielsen.com/encoders/wp-content/uploads/2016/03/Encoding_Install_Config_Policy_Rev_G.pdf
https://engineeringforum.nielsen.com/encoders/wp-content/uploads/2016/03/Encoding_Install_Config_Policy_Rev_G.pdf
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Troubleshooting Issues with the SID/TIC Server 

To start an encoding session, the Encoder must first establish a network connection to a 

properly configured, active SID/TIC Server. Even if the Server resides on the same computer 

as the Encoder, the Server and the Encoder application communicate using TCP/IP protocol. 

Communication issues may occur that prevent encoding from taking place.  

If you see an error message, “SID/TIC Request Failed” or “Unable to establish valid 

connection with SID/TIC Server,” use the following steps to look for root causes. 

Communications with Nielsen Fail 

Check your firewall to ensure it is not preventing communications between the Server and the 

Encoder. 

Communications with SID/TIC Server Fail 

1. To check whether the SID/TIC Server address is correct, on the VOD Content 

Encoder application window, select Configure > System Setup. See Table 5 – 

Summary of Configuration Settings for Figure 8 on page 21. 

2. If the address is valid, note the following to determine whether it is a subnet mask 

or a specific IP address: 

 If the address does not contain any 255 segments, the address is a specific 

IP address, which means the Encoder uses the “direct connection” method of 

connecting to the SID/TIC Server.  

 If the address is set to 255. 255. 255. 255, the address is a mask. Go to 

“Verifying the Discovery Server Is Running” on page 55. 

 

Figure 37 – SID/TIC Server Address on Mask 

Testing the Connection to the SID/TIC Server 

1. Open a command line window. 

2. Type ipconfig and press Enter. 

3. Note the IP address, which is the IP address of the SID/TIC Server host 

computer. 

4. Do one of the following: 
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○ If the IP address in the command window matches the IP address in the Encoder 

Configuration dialog box (Figure 37), go to “Running a SID/TIC Server Test.” 

○ If the addresses do not match, enter the correct address or mask into the 

SID/TIC Server IP Address or Mask field into the Encoder Configuration window. 

See “Configure the VOD Content Encoder Application” on page 19. 

Running a SID/TIC Server Test 

On the Configure menu in the VOD Content Encoder window, select SID/TIC Server Test. 

One of the following occurs: 

 A message appears, “Discovered an active SID/TIC Server at IP address 

xxx.xxx.xxx.xxx.” 

The Encoder is properly communicating with the SID/TIC Server. 

 A message appears, “Invalid response from SID/TIC Server at IP Address 

xxx.xxx.xxx.xxx.” 

It is likely that the IP address identifies a computer that has a SID/TIC Server on it, 

but that the SID/TIC Server is improperly configured. Recheck the SID/TIC Server 

setup at the specified address. 

 A message appears, “Unable to discover an active SID/TIC Server at 

xxx.xxx.xxx.xxx.”  

A properly configured SID/TIC Server is not running at the specified address. 

Recheck the IP address and the configuration of the software and SID/TIC Drive at 

that IP address. 

Verifying the SID/TIC Server Is Running 

1. In Windows Control Panel (or equivalent), select Administrative Tools. 

2. Select Services (#1 in Figure 38). 

3. Check that the Status column shows the server is Started and the Startup Type 

is Automatic. See Figure 39. 

 

Figure 38 – Services Window 
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4. Do one of the following: 

 If the settings are correct, go to “Verifying the Discovery Server Is Running” 

on page 55. 

 If the settings are not correct, right-click the same line and select Properties 

and go to the next step. 

5. In the Trigger Service status section on the General tab, select Start. See Figure 

39. 

6. To set the Server to automatically start, in the Startup type field, select 

Automatic. 

7. Click OK. 

 

Figure 39 – Services Properties Window 

Verifying Installation of the WRR  

1. From the Start menu, open WRR Installer. 

2. Verify the Host WRR Load is successful. 

3. Verify the HOST WRR state is Active. 

4. If WRR is InActive, contact Nielsen Encoder Support (see page 5). Follow the 

procedures in "Deactivate WRR” on page 38 and “Upgrade WRR” on page 40.  
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Verifying the Discovery Server Is Running 

Use the procedure above for verifying the SID/TIC Server is running, except check that the 

Discovery Service is running (#2 in Figure 38). 

Note This step only applies if you rely on the discovery method of identifying a SID/TIC Server. 

The Discovery Server should be running ONLY if you supply a subnet mask instead of a 

SID/TIC Server IP address on the Encoder Configuration window of the Encoder 

application. Discovery Service functionality is not supported in workflows that include 

cloud interactions. For a workaround, contact Encoder Support. See page 5. 

 

Checking the Contents of the WRR 

1. From the Start menu, open WRR Installer. 

 

Figure 40 – WRR Installer Window 

2. In the section, SID/TIC Records on Host WRR, check that the information is 

correct. 

3. Do the expected SIDs and distribution source appear in the list?   

 If not, do most of the SIDs in the list appear to be valid? If any SIDs are 

missing, see “Add a New Distribution Source or SID” on page 43.  

 If the entries appear, are they garbled or missing? If the WRR load status is 

failure, you may need to repair the WRR. See “Repair WRR” on page 42. 
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Issues with WRR File Installation or Upgrade 

Table 10 – WRR Installation Failure Reasons 

If you receive a message that… Because… Do this: 

The WRR is corrupt, invalid, or 

missing 

The WRR file requires repair See “Repair WRR” on page 

42. 

The WRR cannot be installed  Contact Nielsen Encoder 

Support (see page 5). 

Note:  Ensure that the WRR is 

installed on the system 

for which Encoder 

Support created it.  

Validity for the WRR 

installation has expired 

The expiry term for installing 

the WRR file has ended. You 

need a new WRR file. 

Contact Nielsen Encoder 

Support (see page 5). 

WRR is already installed The Install WRR button on the 

WRR Installer dialog box 

(Figure 3) is only for fresh 

installations 

1. Open the WRR Installer. 

2. Perform the “Upgrade 

WRR” procedure on 

page 40 

 

Table 11 – WRR Upgrade Failure Reasons 

If you receive a message that the upgrade 

failed because… Do this: 

Host WRR is active Perform the “Upgrade WRR” procedure on 

page 40. 

WRR being upgraded is older than installed 

WRR 

Contact Nielsen Encoder Support (see page 

5) 

WRR being upgraded has older 

nextAvaibleTic (sic) values than installed 

host WRR 

Contact Nielsen Encoder Support (see page 

5) 
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Deactivating the Discovery Service 

Important Perform this step only if you do not want the SID/TIC Server on this computer to be 

“discovered” by VOD Content Encoders. 

1. In Control Panel (or equivalent), open Administrative Tools > Services. See #2 in 

Figure 38. 

2. Right-click Nielsen Discovery Service and select Properties. See Figure 41. 

3. To prevent the application from auto-starting during boot up, use the Properties 

option to change the Discovery Service on this machine from an Automatic 

Service to a Manual Service.  

4. Open the VOD ServicesMonitorTool from taskbar and uncheck the “Monitor 

Discovery Service” checkbox to disable the discovery services monitoring. 

 

Figure 41 – Discovery Service Properties 
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Troubleshooting Issues with Transferring Metadata 

The VOD Content Encoder File Transfer Service periodically transfers any available feed-

point metadata files to the Nielsen CF. Follow these steps when metadata has not properly 

transferred. 

Verifying the File Transfer Service Is Correctly Operating 

1. In the VOD Content Encoder application, select View > Log File. 

2. Scroll through the log file, searching for any of the following messages. 

 The following message indicates that a file was successfully transferred to 

the CF at the time that the message was sent. 

Successfully transferred file xxx_yyy_adi.xml 

(where xxx is the SID and yyy is the first 

TIC). 

 The following message indicates that no files have been transferred since the 

last message from the File Transfer Manager. In the absence of other more 

specific error messages, however, this is not an error report. Instead, it 

merely indicates that there were no feed-point metadata files ready to be 

transferred.  

FTM: Transferred 0 files. 

 An error message in the error log or no reports from the File Transfer 

Manager over a long period indicate File Transfer Service may not be 

properly functioning. See “Verifying the File Transfer Manager Service Is 

Running” on page 58.  

Verifying the File Transfer Manager Service Is Running 

1. To ensure that the File Transfer Manager Service is running, from the Start 

menu, select Control Panel > Administrative Tools > Services (Figure 38).  

2. From the list of services, look for Nielsen File Transfer Manager Service and do 

one of the following: 

 If the File Transfer Manager Service does not appear in the list, the Encoder 

software was not properly installed. Uninstall and reinstall the VOD Content 

Encoder software. 

 If the File Transfer Manager Service DOES appear in the list, check the 

status of the Trigger Service. If it is not Started, right-click on the File 

Transfer Manager Service list entry and select Start. 

3. From the View menu on the VOD Content Encoder window, select Configure > 

System Setup. 

4. Verify the following values. For the settings, see Table 6 – Feed-Point Transfer 

Parameters for Figure 14 on page 25. 
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5. Click Save. 

6. On the File menu in the VOD Content Encoder window, select Transfer. If all 

components are properly configured, all files should transfer from the metadata 

folder to the CF and the original files to the arch_metadata folder. A message 

should confirm that the transfer was successful. If the transfer fails, do the 

following: 

 Check the network configuration and firewall settings on the Encoder. 

 Verify that a third party FTP application is not running on the same subnet as 

the File Transfer Service by doing the following: 

a. In Control Panel (or equivalent), open Administrative Tools > Services 

(Figure 38). 

b. Examine the list to see if an FTP application other than the Nielsen File 

Transfer Manager Service is running. 

To prevent a conflicting FTP application from auto-starting during boot 

up, use the Properties option to change the FTP service from an 

Automatic Service to a Disabled Service. 

Note If File Transfer Manager Service problems persist, call Nielsen Encoder Support to check 

the status of the metadata server at the CF. See “Customer Support” on page 5. 
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Appendix 

Contents of an XML Trigger File 

The following is an example of a Sample-File-Trigger.xml file that includes clusters. 

<ContentEncodingParams> 

 <InputFile>   

  C:\temp\VoD\Source\Sample.mpg   

 </InputFile> 

 <OutputFile>  

  C:\temp\VoD\Encoded\Sample-enc.mpg  

 </OutputFile> 

 <SID> 

  9000  

 </SID> 

 <AssetId> 

  Test ID 1 

 </AssetId> 

 <AssetName> 

  This is for File Trigger Encode Test. 

 </AssetName> 

</ContentEncodingParams> 

Example: 

 Contents of an ADI File Trigger XML File 

The following is an example of a Sample-ADI-File-Trigger.xml file. For definitions of the 

parameters, see Table 3 – Parameters Defined for Standard XML File-Encoding on page 12. 

<ContentEncodingParams> 

 <InputFile> 

  C:\temp\VoD\Source\Sample.mpg 

 </InputFile>  

  <OutputFile> 

  C:\temp\VoD\Encoded\Sample-enc.mpg 

 </OutputFile>  

  <AdiFile> 

  C:\temp\VoD\ADI\Sample-ADI.XML 

 </AdiFile>  

  <SID> 

  9000 

 </SID>  

  <AssetId> 

  TEST0001137522386093 
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 </AssetId>  

  <AssetName> 

  TEST24S04E01_Title 

 </AssetName>  

</ContentEncodingParams> 
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Glossary 

A 

ADIFileName 

The name of the CableLabs file (if any) that will be transferred to the Nielsen Data-Collection Facility along with the 

NMR Feed-Point Metadata File. 

ADI-XML File 

The ADI.XML file holds parameters (MPEG file name, asset name, asset ID, episode ID) used in content encoding. In 

tar-file processing, the File Trigger Service extracts a set of encoding parameters from the ADI.XML file before 

starting the encoding session. When the tar-file encoding session ends successfully, the Trigger Service modifies the 

ADI file, updating the MPEG file name and the checksum to correspond to the newly encoded MPEG file. 

AssetId 

The ID of the encoded content. May be derived from an Asset ID field in the CableLabs file. 

AssetName 

The name of the encoded content. May be derived from an Asset Name field in the CableLabs file. 

C 

CF 

Nielsen Collection Facility. 

D 

Decoder 

An application that processes an audio stream (PCM or AC-3) and reports on the Nielsen watermarks (NAES II, NW, 

or both) that it finds in the audio stream. 

E 

Ending TIC 

The value of the last TIC reserved for this asset. 

F 

FD 

Final Distributor. An attribute in watermark that identifies the watermark as inserted by a distributor. 

FileSizeBytes 

The size of the encoded file in bytes. 
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FileSizeSeconds 

The approximate duration (in seconds) of the encoded file. This is just an approximation. For very long files, the 

estimated size may be incorrect by several seconds. 

N 

NAES II (Nielsen Audio Encoding System II) 

Also known as NAES II. The second-generation method of inserting a SID (Nielsen source identifier) and time stamp 

into a TV signal. 

NW (Nielsen Watermarks) 

A Nielsen technology that places an audio watermark in a lower-frequency portion of the active program than does 

NAES II technology. Its lower-frequency position enables NW to be more robust and much less likely to be 

“compressed out” of the program audio by TV distribution providers without interfering with the viewer’s listening 

experience. Unlike NAES II, however, NW code cannot be overwritten by successive program distributors. 

P 

PC (Program Content) 

An attribute in a watermark that identifies the watermark as inserted by a programming source. 

S 

Scratch Folder 

The scratch folder must be an empty folder. It is used in processing the tar file specified in the XML trigger file. This 

tar file contains the media content file and an optional ADI XML file. After encoding, encoded media content and the 

optional ADI XML file are packaged back into a tar file specified in the XML trigger file. 

SID (Source Identifier) 

Unique identifier that Nielsen assigns to each subscriber (or distribution source) using audio watermarking. Included 

as a component of each watermark, the SID uniquely identifies the distribution source. A subscriber may have more 

than one SID. 

StartingTIC 

The value of the first TIC reserved and the first TIC inserted into this asset. 

TIC (Time in Code) 

A time code used for encoding offline content. See Time Stamp. 

Time Code 

See Time Stamp. 

Time Stamp  

A component of the watermark that identifies one of two attributes: 

 A numeric representation of the date and time at which the watermark was inserted in 

the stream (referred to as a timestamp or time code, and typically used when 
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streaming content is watermarked as it is being broadcast). 

 A numeric representation of the time-in-content (referred to as a TIC, and typically 

used when watermarking audio content that is stored in a file). By subtracting the 

starting TIC from the TIC extracted from the watermark, one can determine how 

many seconds into the stored file the watermark is located. 

In NAES II watermarking, the timestamp or TIC is represented as a 32-bit unsigned integer. The timestamp in Nielsen 

watermarking uses only 29 bits. 

Trigger File 

An XML file the presence of which in a specific folder triggers the start of a VOD content encode. The path where 

these trigger files are located is identified by the “EncoderParamFolder” setting in the EncoderConfig.txt file in the 

VOD ROOT / etc folder. 

W 

Watermark 

Used as a noun, also referred to as an audio code, a watermark is a sequence of bits that the Nielsen Watermark 

software inserts periodically in an audio stream. The components of the watermark (SID, timestamp or TIC, and a PC 

or FD flag to identify the point of entry into the flow of content distribution). With these components, a watermark can 

uniquely identify the portion of audio from which the watermark is extracted, that is, the distribution source to which 

the audio content can be credited.  

Used as a verb, the term “to watermark” means to insert Nielsen codes into an audio stream. 


